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Home Page Walkthrough

Home Page Walkthrough

1. Tile View and List View - Use the         and         icons to toggle between the Tile view and the List view respectively. 
When users switch from the Tile view to the List view, the screen displays only the ‘Last Accessed’ assets. Click the All 
Assets link if you want to view all available assets.

2. Sort - At a broad level, you can sort assets based on Domains. In addition, you can also sort these assets based on 
Name, Owner, Type and Last Accessed Date using the Sort By drop-down list. Lastly, you can use the         icon to sort 
assets in the Ascending or Descending order. 

3. Search - Type a keyword or phrase in the Search textbox to limit assets displayed.

4. Advanced Search - It allows you to search for assets based on additional search criteria such as “Published by Me”, 
“Published to Me”, “Scheduled by Me” and “Scheduled to Me”.

5. Filters - Use the         icon to locate the desired assets based on specified criteria such as Starred, Storyboards, Reports, 
Custom Reports, and Merged Reports.

6. Data Domains - It is visible at the right side of the screen in the List view. In the Tile view, click the          icon to view 
and select the desired data domain. You can click on the data domain to create a new report.
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7. Notifications - Click the           icon to view the system-generated notifications. As an alternate, you can also view 
notifications by opening the Notifications folder.

8. Downloads - Click the          icon to access completed exports. As an alternate, you can also view your downloads by 
opening the Downloads folder. 

9. Support - Click the            icon to get the contact details of the MSA Product Support Helpdesk.

10. User Preferences - Click your Username           initial placed at the extreme right top corner of the screen to define 
user preferences, change user password, set mobile accessibility and to logout from the application. 

11. Right-click / Ellipsis options - Click the          icon placed at the right of any desired asset to open the menu and select 
from the list of most frequently performed tasks such as Rename, Export, Publish, Delete, Schedule etc. Some menu 
options are available to the asset owners only.

12. New - Use this button to create new Folders, Reports (Databooks), or Storyboards. 
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Report Screen Walkthrough

1. Attribute Panel - Placed on the left, this panel contains available attributes organized in folders. Folders and the         
attributes within are listed alphabetically.

2. Report Filters - Select any attribute as a report filter which will be applicable to the entire report. 

3. Report Rows, Columns, and Pages - These are the report dimensions on a report and they serve as locations for    
dragging the attributes and measures.

4. Save - Use the Save button to save a report.

5. Generate - There are two Generate buttons on the screen. Use either of them to generate a report after specifying the 
report dimensions. Users can use the generate button placed at the top of the screen or the generate button placed at 
the center of the screen. 

6. Preview - You may use the Preview button to view the report in a non-edit mode prior to publishing it.

7. Controls - Use the Controls menu to navigate pages and to apply user filters in a report/chart.
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2. Dataset Functions Menu- This menu helps to enhance the report data using the post-report generation functions 
mentioned below: 
     •	 Alerts and Color Conditions to apply color conditions to data in the extracted report.
     •	 Filter Conditions to include or exclude certain data values based on conditions.
     • New Attribute Value to create custom values for attributes.
     • New Measure Value to create new measures.

3. Display Options Menu - This menu provides a variety options to manage various report elements such as filter           
attribute, user filter attribute, footer, report specifications, hide attribute values, and control wrapping.

4. Report Options Menu - Use this menu option to create report links, set publishing locks or apply row and columns 
functions such as sum, mean, and so on. 

Grid Column Options

After a user generates a report, click on           in any desired report column to open the column options dropdown menu. 
The menu options differ for attributes vs. metrics. This menu provides a variety of options to organize data in a desired 
manner. Some of the options available are: Sort, Filter, Top/Bottom, Color, Hide, and so on.

1. File Menu - This menu contains option to save, publish, export, etc. Some menu options are greyed out until you save 
a copy of the report. Also note that some menu options are only available to the asset owner.
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Create Report

Create Report
	 Step 1: On the Home page, select the desired Data Domain.

	 Step 2: Drag the desired attributes from the left panel onto the Rows, Columns, Pages, and Filters areas.

	 Note: At least one measure must be placed on one of the report dimensions.

	 Step 3: Click Generate.

Step 4: The system will process the request and generate a report.
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Create Hierarchy 
Adding a hierarchy to a report allows the information to be presented in a condensed format and provides the ability to 
drill to the additional levels of details as needed or to stack and view all requested items without drilling. Hierarchies can 

The selected type of hierarchy (Replacement, Nested, or Stacked) is indicated with its new name in the report 
dimension section.

Step 1: Drag the attribute that will be the second level (Child level) of the hierarchy (for example, Sub Category) 
on top of the attribute that will be the top level (Parent level) of the hierarchy (for example, Category) in the 
report dimension section.
Step 2: In the Hierarchy dialog box, enter the new name and select the appropriate type for the hierarchy.
Step 3: Click Done.

Users can choose from three types of hierarchies:
•	 Replacement Hierarchy
•	 Nested Hierarchy
•	 Stacked Hierarchy
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Replacement Hierarchy
The Replacement hierarchy is the default hierarchy selection and enables a drill-down to the child level, displaying only 
the child level of the drilled item. In the below example, if you click the plus sign of the Other Tobacco Products category, 
the system will navigate you to the Subcategories of the Other Tobacco Products category in the table. Use the Category 
link (indicated with a dotted arrow in the right-side screenshot) to navigate back to the parent level.

Nested Hierarchy
The Nested hierarchy provides the drill ability on the report and displays the parent and the child totals simultaneously. 
In the example below, if a user clicks the Other Tobacco Products category, the system will display the subcategories 
related to the Other Tobacco Products in the same table along with their totals.

Note: Clicking on the +1 control (placed at the left corner above the table) would expand all parents to display their       
corresponding child levels in a single click.
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Stacked Hierarchy
The Stacked hierarchy is a type of hierarchy that enables users to view all selections without drilling. Stacking will display 
the attributes/groups in the selected order and will sort the items within each attribute/group. An example of a report 
generated applying the stacked hierarchy is demonstrated below wherein the attributes such as Category, Sub Category, 
and Store State are arranged in a stacked hierarchy and the report is filtered using the Category attribute with Measures 
in the Columns area.

Note: In a Stacked Hierarchy, there is no Parent-Child relationship between the attributes.

	 Step 1: On the New Report Template screen, search for the Category, Sub Category, and Store State attributes 		
	 in the left-hand panel and drag them to the Rows area.

Step 2: To create a hierarchy, drag Sub Category on top of Category and then add Store State on top of the two.
Step 3: In the Hierarchy dialog box, drag and drop the selected attributes to arrange them in the desired order 
(for example, Category - Sub Category - Store State) and edit the Hierarchy Name to reflect the order. 
Step 4: Select the Stacked option and click Done to return to the previous screen.
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Step 7: Add Category as a report filter by dragging it from the left-hand panel and dropping to the Filters area.
Step 8: Click the Generate button to generate the desired report as per the specified report parameters.
The system will generate a report which will display all items in a selected Category (for example, Other Tobacco 
Products) at the top followed by all the Subcategories, then States, with the values within each of these attribute 
sorted in the descending order as shown in the below screenshot.

Step 5: Add Category as a report filter by dragging it from the left-hand panel and dropping to the Filters area.
The system opens the Apply Filters dialog box.
Step 6: Select the Other Tobacco Products item from the left panel and click the right-pointing arrow to send it 
to the right panel.
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User Filters can be applied on a Report or Storyboard, enabling users to easily slice and dice the data for a custom view. 
User Filters can be applied at any point while creating/running a report.

	 Step 1: Click the desired attribute from the left panel and select the Add User Filter option from the drop-down 		
	 list.

	 Step 2: Select the desired User Filter Display options and click Done.

Apply User Filters
Creating a User Filter

	 Step 3: The User Filter attribute (indicated as UF) appears in the Filter area with a dropdown menu on the 		
	 right hand side of the page that can be used to modify User Filters currently applied to the report. 
	 Users may also modify or delete the User Filter by clicking the down arrow and selecting the corresponding 		
	 option from the dropdown menu.
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User Filters for Measures
Users also have the ability to add a User Filter for Measure Durations and Versus Periods. This enables users to select 
the duration and/or versus period across the measures on a report.

	 Step 1: Click the Measures drop-down list in the lower left corner of the page.
	 Step 2: Select Add User Filter from the drop down list.

	 Step 3: Click the + symbol to expand the list of Measure Parameters. Select the option Duration(duration).
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	 Step 4: Select the desired Measures for the report. 

	 • Best Practices recommendation: Measures should all be defined with the same duration when      			 
	 adding a Duration User Filter. Upon selecting a Duration from the User Filter, all metrics will refresh and 		
	 populate with the selected Duration applied.

	 Step 5: Select the 13W option from the Duration User Filter drop down menu.

Note: Users can also create a Measure Versus User Filter to change the lookbacks of all the measures on the 
report. The process of adding it to the report would be identical, but the user would instead select a Versus 
option. In addition, this User Filter would function like the Duration User Filter in the example above.
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After selecting from the User Filter drop down menu, the selection will be reflected in the Filters line as shown above.
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Stubs

Stubs
Stubs in Dhiva are made up of a combination of Attributes and static/dynamic objects (Lists, Group, Conditional lists). 
They are structured and function similarly to a Stacked Hierarchies. Stubs are notated with an "ST" prefix and is listed 
in the Stubs section at the top of the attribute panel. A Stub can be used in any report on Pages, Columns, Rows, or as a 
User Filter. 

Note: Stubs cannot be used directly as a Filter.

Producer users can create Stubs. A Stub can be personal/private or can be made global by an admin. Unlike stacked       
hierarchies, Stubs are not report specific and can be used in any report in that domain. 

Stubs can be used anywhere on the report layout but cannot be used as a report filter. In addition to being placed on 
rows/columns/pages, Stubs can be used as User Filters. Using Stubs as User Filters enables the user to change the focus 
of the report.

Under the Manage Stubs option, users can perform the following tasks:
•   Create New Stub
•   Copy, Edit Name, Delete

Create New Stub
The following are two scenarios for Stub creation and examples of how to create them:
•   Create Stub to use on Report 
•   Create Stub to use as a User Filter 

Create Stub to use on Report

Adding multiple objects to a Stub stacks all the selected values into one column, allowing similar functionality 			 
to a Stacked Hierarchy. An advantage Stubs have over Stacked Hierarchies is that they are located in the left-hand			
panel, making them reusable in other reports (similar to Groups).

	 Step 1: From the left panel, click on Stubs dropdown and Select Manage Stubs. 
	 Step 2: If a user hasn’t created a Stub before, a popup will prompt them to name the first one they create.             	
	 Otherwise, select Options > New.
	 Step 3: Provide an appropriate name for the Stub (for example “Dist HQ-Chain-Mfr)
	 Step 4: By using text search or by navigating the folder structure of available Attributes, Lists, and Groups, find 		
	 and select the following attributes to add to this Stub: Distributor HQ, Chain Name, and Manufacturer. 
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	 Note: In addition to Attributes, Stubs can also contain Groups, Lists, and Conditional Lists. 

	 Step 5: Click Continue. 

	 Note: In this window, users can also rearrange and delete attributes. Using the Add button, additional attributes/	
	 lists/groups can be added to the Stub.
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	 Step 6: Click Save. Now this Stub will be available under the Stubs Attribute.
	 Step 7: Expand the Stubs section in the lefthand panel, locate the new Stub Dist HQ-Chain-Mfr, then drag it 		
	 into the Rows section.
	 Step 8: After clicking Generate, users will see that all values for Distributor HQ, Chain Name, and Manufacturer 		
	 are displayed in one column, like they would be when placed in a Stacked Hierarchy. 

	 Note: Any Filters/User Filters added to the report will be respected in the stub as well.

Create Stub to use as a User Filter

To use Stubs as a User Filter, at least one Stub must be added to the report to get the Add User Filter option to appear in 
the Stubs section. Then in the popup window, the user must select the Select User Filter Values to customize the list of 
Stubs in the User Filter dropdown menu.

	 Step 1: From the left panel click on Stubs and Select Manage Stub.
	 Step 2: In the popup window, select Options -> New to create a new Stub.
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	 Step 3: Provide appropriate name for the Stub (for example “DISTRIBUTOR HQ”), as this Stub will contain the            	
	 Distributor HQ attribute.
	 Step 4: Locate the attribute Distributor HQ, select it, then click Continue. 

	 Step 5: Save this Stub. After saving the newly created Stub it will become available under the Stubs Attribute 		
	 in the lefthand panel.
	 Step 6: Create another Stub by clicking on Options > New.
	 Step 7: Repeat steps 3-5 to create Stubs for Chain (with the name "CHAIN" provided in this example) and       		
	 Manufacturer (with the name "MFR" provided in this example) as well.
	 Step 8: Expand the Stubs section in the lefthand panel, locate the Stub CHAIN, then drag it into the Rows 		
	 section.
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	 Step 9: Once a Stub has been placed onto the report, a new option will appear in the Stubs dropdown menu. 		
	 Click Add User Filter. Here, users can select Filter Actions and Appearance settings, such as whether a 			 
	 selection is mandatory, generation settings, etc. 
		  • Select the option Select User Filter Values. This will allow the user to hand pick the Stubs to         		
		  include in this UF dropdown in the report. Without selecting this option, all available Stubs (personal 		
		  and global) will be listed in the UF dropdown. 

	 Step 10: Click Continue. 
	 Step 11: In the next window, select the three Stubs that were created in this example (CHAIN, DISTRIBUTOR HQ, 		
	 MFR), then use the right arrow to add them to the Selected Values List, as pictured below. 
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	 Step 12: Click Done. A User Filter selection box will appear in the top right of the report. Notice that only the 		
	 three Stubs we selected are shown in this list.
	 Step 13: Select CHAIN in the User Filter dropdown. Then click Generate.

	 Step 14: In the Stub User Filter dropdown, select DISTRIBUTOR HQ. Then click Generate.
		  • Now the values for CHAIN are swapped out for those of DISTRIBUTOR HQ. 
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Copy, Editing Names, and Deleting Stubs
Users can make a copy of a Stub, edit a Stub name, or delete a saved Stub by using the following procedure:
	 Step 1: Select the desired Stub attribute in the attribute panel OR click on the Stubs drop down menu.
	 Step 2: Click the down arrow and select the Manage Stub option.
	 Step 3: Select the appropriate Stub name from the name dropdown list.
	 Step 4: Click the Options dropdown menu and select the Copy, Edit Name, or Delete option.

	 Note: These options will vary if the user is not the owner of a Stub.

Stacks vs Stubs Review
Though Stacked hierarchies and Stubs are similar in that both can be used to combine multiple attributes, there are a 
few key differences. One main difference is that Stubs are reusable and can be made Global to share with other users. 
Furthermore, Stubs are treated as objects in terms of usability on reports--rows, columns, and pages. Also, Stubs can be 
used in User Filters, whereas a stacked hierarchy cannot.

Limitations of Stubs
•    Similar to Stacks by default, Stubs can only contain a maximum of 4 objects (attributes, groups, lists).
•    A report has the limit of one Stub to be used in rows, columns, or pages.
•    A report can have up to:
	 o    4 Stacks OR
	 o    3 Stacks + 1 Stub
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Manage Lists
A List is a preset of values within an attribute that can be used as a Filter. Users can manually select, dynamically filter, or 
import a file with a list of items. Under the Manage Lists option, you can perform the following tasks:

Create List
Users can select multiple items in an attribute and create a List. For example, for the Store State attribute, you may 
create a list of your favorite states, such as Arizona, California, and Florida and use it as a report Filter. The same example 
is demonstrated below:

	 Step 1: On the Create Report screen, select the desired attribute (for example, Store State in the Geo Attributes 		
	 section) in the attribute panel.
	 Step 2: Click the down arrow and select the Manage Lists option.

Step 3: Enter an appropriate List Name (for example, "Tri State Area") in the Enter New List Name dialog box and 
click Done.
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	 Note: Press the Shift key to select multiple adjacent items in an attribute, while press the Ctrl key to select 	
	 multiple non-adjacent items in the attribute. Use the left-pointing arrow to remove selections from the list. Select 	
	 the Exclude checkbox to include all but the selected item(s).

	 Step 5: Click Save. The system will display the message List created successfully.
	 Step 6: Click Done.

While generating a new report, users can use this list in filters, rows, or columns as needed as demonstrated further.

	 Step 7: On the Create Report screen, drag the list attribute from the left panel onto the Filter area.
	 Step 8: In the Apply Filters dialog box, choose the desired list (for example, Tri State Area) from the Select List 	
	 dropdown box and click Done. 

Step 4: Select the desired items (for example, AZ, CA and FL) from the left side of the Selection Panel and click 
the right-pointing arrow to move them to the right side of the panel.
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Manage Lists

	 Step 9: Drag the desired attributes onto the Rows, Columns, and Pages as needed and then click the Generate 		
	 Report button.

Running a report with an attribute List (for example, Tri State Area) will provide the results for the items that match the 
selected criteria as shown in the below screenshot.

Import List
Instead of creating a list, you can also import a list into Dhiva by using a template. An example to import a list of your 
favorite Store States is demonstrated below:

	 Step 1: On the Create Report screen, select the desired attribute (for example, Store State in the Geo Attributes 	
	 section) in the attribute panel.
	 Step 2: Click the down arrow and select the Manage Lists option.
	 Step 3: Enter an appropriate List Name (for example, Favorite States) in the Enter New List Name dialog box and 	
	 click Done.
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Step 4: In the Manage List dialog box, select the Import option.
Step 5: Select the By Using ID or By Using Name options from the template dropdown menu depending on how 
you would like to enter values into the template.
Step 6: Click the Download link to download the corresponding template. In this example, users should       
download the Store State.xlsx file onto their desktop.

Step 7: Open the file and click the Enable Editing button to enter the relevant data (for example, frequently      
visited store states) in the desired column.
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Step 8: Once done, save the import file in Excel and close the file.
Step 9: In the Manage List dialog box, click the Browse button to navigate to the import file location and click the 
Open button to load the file.

	 Step 10: Click the Save button to save the list. 
	 Step 11: Click the Done button to close the Manage Lists dialog box.

While generating a report using the list you just created, choose the appropriate List Name from the Apply Filter dialog 
box as mentioned in the “Create a List” procedure steps 7 to 9.

Running a report with an attribute List (for example, Favorite Area) will provide the results for the items that match the 
selected criteria as shown in the screenshot below.
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Dynamic List
Dynamic Lists allows users to save and apply criteria defined through the advanced search features in the manage lists 
window to create dynamic lists which will update when data is refreshed. 

	 Step 1: On the Create Report screen, select the desired attribute (for example, Store ID in the Geo Attributes 		
	 section) in the attribute panel. 
	 Step 2: Click the down arrow and select the Manage List option.
	 Step 3: Create a new list and enter an appropriate List Name (for example, "Stores in my chain").

Step 4: In the Manage List dialogue box, select the Advanced Search option.
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Step 5: Select the desired Attribute to filter (for example, Chain Name) and select the desired Chain Name. This 
will filter Store IDs down to the selected Chain. 
Step 6: Select Save and Apply Criteria then click Done. This will create a dynamic list of the Store IDs in the       
selected Chain, which will update each time the data is refreshed.

Step 7: Users can now use Lists and Conditional Lists as attributes on a report. Drag the list that was just created 
on Store ID onto rows.
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Generating the report with the newly created list on rows will output a list of Store IDs that will dynamically update as 
data is refreshed, if a new store is added, or an existing store is removed from the chain.

Copy/Edit/Delete List
Once you save a List you have created or imported, you will also see the options to copy, edit name, and delete a list. 
These options are available for any saved Lists. The procedure is mentioned below:

	 Step 1: Select the desired attribute in the attribute panel.
	 Step 2: Click the down arrow and select the Manage Lists option.
	 Step 3: In the Manage Lists dialog box, select the appropriate List Name from the dropdown list.
	 Step 4: Click the Options dropdown menu and select the Copy, Edit Name or Delete option to perform the        		
	 corresponding actions.



Page 31 of 63Proprietary and Confidential

Enterprise Data Warehousing Sales Execution Trade Program Management Market & Consumer Insights

Manage Conditional Lists

Manage Conditional Lists
A Conditional List is a dynamic list of attribute items that meet the criteria of the expression statement(s). It is similar to an IF 
THEN statement in programming languages. The list of items included in a Conditional List is updated with each data refresh.

Create Conditional List
For a Conditional List, first users create a list and then specify conditions. When a Conditional List is selected, the system 
generates a report with the data fulfilling the condition(s). For example, you may wish to generate a store names report 
where the sale of a particular product is declining. The same example is demonstrated below:

	 Step 1: On the Create Report screen, select the desired attribute (for example, Store Name in the Geo Attributes 	
	 section) in the attribute panel.
	 Step 2: Click the down arrow and select the Manage Conditional Lists option.

Step 3: Enter an appropriate name (for example, "Depleting Sale") in the Enter New Conditional List Name        
dialog box and click Done.
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Step 4:In the Manage Conditional Lists dialog box, click the Apply Filters link.

Step 5: In the Select Filter Values To Apply dialog box, select the desired attribute (for example, Category) from 
the dropdown menu.
Step 6: Optional - You may use the textbox to search for the desired item by text string or use the Advanced 
Search to limit the available list based on attribute values. (For example, Salty Snacks).

	 Step 7: Select the desired item (for example, Salty Snacks) from the left side of the Selection Panel and click the 		
	 right-pointing arrow to move it to the right side of the panel.

	 Note: Press the Shift key to select multiple adjacent items in an attribute, while press the Ctrl key to select 		
	 multiple non-adjacent items in the attribute. 

	 Step 8: Select another attribute (for example, Week) from the Select Attribute dropdown box.
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Step 9: Select and add the desired item (for example, Current Relative Week) to the right side of the panel as 
shown below:

	 Note: Select the Relative checkbox in order to select the current relative week.

	 Step 10: Click Done.
	 Step 11: In the Manage Conditional List dialog box, click the Choose Metric link to define measures.

Step 12: Select the appropriate option (for example, Unit Volume) from the Metric dropdown list.
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	 Step 14: Select < from the Operator dropdown list.
	 Step 15: In the Compare To dropdown list, select Condition. This will create the second condition.

	 Step 13: Select the appropriate values (for example, CY and 13W) from the Versus and Duration dropdown lists 
	 respectively, then click Done.

	 Step 16: Click the Apply Filters link.
	 Step 17: Repeat steps 5, 6, and 7 to select Salty Snacks as a Category.
	 Step 18: Repeat steps 8, 9, and 10 to add Week attribute.
	 Step 19: Click the Choose Metric link to define the measure for the second clause.
	 Step 20: In the Define Measures dialog box, click the plus sign to duplicate the first measure.
	 Step 21: On the second measure, select appropriate values (for example, PY and 13W) from the Versus and 	
	 Duration dropdown lists respectively, then click Done.
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	 Step 22: On the Manage Conditional Lists dialog box, click the Expression button to review the conditional ex		
	 pression. 

	 Step 23: Click Done to return to the Manage Conditional Lists dialog box. 
	 Step 24: Click Save to save the conditional list, then click Done to close the dialog box.
	 System will send a message, “Conditional List saved successfully.”

Add Conditional List to Report
On the New Report Template screen, there will be some default attributes appearing in the Filters and Columns area 
such as Relative Week in Filters and Measures in Columns. Users may add more attributes to generate a desired report. 
For example, you can generate a report to get the store names where the sale of salty snacks is declining for 13 weeks 
in the current year as compared to sales in the previous year for the same period (13 weeks). In this example, users will 
add attributes such as Category, Store Names, Conditional List, and Measures to the Filters, Rows, and Columns areas as 
demonstrated below:

	 Step 1: Drag the Category attribute from the left panel to the Filters area and select Salty Snacks from the list. 
	 Step 2: Drag the Store Name attribute to the Filters area and select "Depleting Sales" from the Select List 		
	 dropdown menu. 
	 Step 3: Add the Store Name attribute in the Rows area.
	 Step 4: Click Measures to add the second measure and select the desired Versus and Duration 
	 (for example, PY and 13W), then click Done.
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	 Step 5: Click the Generate Report button.

The report will reflect the names of the stores where the sale of salty snacks is dropping in the current year compared to 
the previous year.

Copy/Edit/Delete Conditional List
Users can make a copy of a Conditional List, edit a Conditional List name or delete a saved Conditional List by following 
the procedure mentioned below:

	 Step 1: Select the desired attribute in the attribute panel.
	 Step 2: Click the down arrow and select the Manage Conditional Lists option.
	 Step 3: Select the appropriate List name from the dropdown list.
	 Step 4: Click the Options dropdown menu and select the Copy, Edit Name, or Delete option.
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Create the Multi-Statement Conditional List with Grouping

When a Conditional List is selected, the system generates a report with the data fulfilling the condition(s). For example, a 
user might want to produce a report listing stores that are selling products from their manufacturer within both Category 
A and Category B. However, consider that they want to identify stores that haven’t sold any items from their top brand 
families within those categories (Brand B in the Beer category and Brand W in the Wine category) during the past 13 
weeks. This example is demonstrated below:

Within a Conditional List, users have the option to include multiple expression statements connected by either AND or 
OR operators. Evaluation of the statements follows the standard rules for order of operations.

When a Conditional List contains 3 or more statements, it is recommended to apply grouping to ensure expected results. 
Grouping places parentheses around statements while compiling the query, resulting in that group of statements being 
evaluated first. When multiple groupings are present, they are evaluated from the innermost grouping and then expands 
outward to the outermost grouping.

Note: Grouping is not necessary when all statements are joined by the same logical conjunction (such as all “AND”s or all 
“OR”s), as the order of operations does not impact the results in such instances. However, when using a combination of 
logical conjunctions, grouping is recommended. 

In order to create a group of statements, users need to select the checkbox next to the statements they want to be        
included in the group. When the checkboxes are checked for 2 or more consecutive statements, the Group icon (       ) will 
be enabled, allowing users to group the statements.  

As shown in the screenshot below, if a grouping needs to be undone, users can ungroup the statements by clicking the 
Group icon for the relevant grouping. 

Grouping within a Conditional List
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Note: We are using the Store Name attribute in the demo database in this example. We recommend using a store number 
attribute if available, to create a unique list of stores.   

	 Step 1: On the Create Report screen, select the desired attribute (for example, Store Name in the Geo Attributes 		
	 section) in the attribute panel. 
	 Step 2: Click the down arrow and select the Manage Conditional Lists option. 
	 Step 3: Enter an appropriate name (for example, "Not Selling My Top BFs") in the Enter New Conditional List 		
	 Name dialog box or select New from the Options dropdown menu and then click Done. 
	 Step 4: Create the required statements in a logical sequence. In order to group statements, they must be        		
	 consecutive or sequential. 

	 Step 5: Once all statements are finished, users can start grouping them as shown below. Notice the Grouping 		
	 button (     ) is grey until a user selects multiple consecutive statements. 
	 To do this, select the checkboxes next to the first two statements and then click the Grouping button located 		
	 above them. This action will result in the addition of a blue shading beside those statements.     
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	 Step 7: Click Save and Done. This Conditional List is now ready to be added to a report.

Dhiva will evaluate the first two statements, followed by the last two, and conclude by combining them using the OR 
operator. We can better visualize this by viewing the Expression. 

In other words, it reads:
 
	 ((Statement 1 AND Statement 2 
 		               OR
 	 (Statement 3 AND Statement 4))

	 Step 6: Select the checkbox for the third and fourth statements then click the Group button. Blue shading will be 		
	 added to the left side of the statements and users should see something like this.
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Manage Groups
A Group is a virtual attribute that can include a list and/or aggregates of the members of the selected attribute. It is 
denoted with a "G" pre-fix in the attribute panel.

Under the Manage Groups option, users can perform the following tasks:
•	 Create New Group
•	 Copy Group, Edit Group Name, Delete Group

Create Group with No Sub Groups

You can place multiple items in an attribute and create a group. For example, in the Category attribute a user may 
create a group called "Confectionary" and place the items such as Alternate Snacks and Candy under it. This example 
is demonstrated below:

	 Step 1: Select the desired attribute (for example, Category) in the attribute panel.
	 Step 2: Click the arrow and select the Manage Groups option.

Create New Group
The following are the two scenarios for Group creation:
1.	 Create Group with No Sub Groups
2.	 Create Group with Sub Groups
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	 Note: Press the Shift key to select multiple adjacent items in an attribute, while press the Ctrl key to select 	
	 multiple non-adjacent items in the attribute. Use the left-pointing arrow to remove selections from the list.

	 Step 5: Click Save. The system displays the message "Group saved successfully."
	 Step 6: Click Done.

	 Step 3: Enter an appropriate Group Name (for example, "Confectionary") in the Enter New Group Name dialog 	
	 box and click Done.

	 Note: If the selected attribute has saved groups, click the Options menu and select the New option to display 	
	 the Enter New Group Name dialog box.

	 Step 4: Select the desired items (for example, Alternate Snacks and Candy) from the left side of the selection 	
	 panel and click the right-pointing arrow to move them to the right side of the panel.
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Users will find the group denoted with a "G" prefix in the attribute panel as shown in the screenshot.

Running a report with a Grouped variable (for example, Confectionary) will provide sum total of each item included 
in a group as shown in the below screenshot.

Create Groups with Sub Groups

Users can create multiple sub groups in a group. It is an aggregate of the selected attribute members. For example, the 
group called "Hard Drinks" can have “Liquor & Beer” and “Wine & Cold Beverages” as sub groups. The same example is 
demonstrated below:

	 Step 1: Select the desired attribute (for example, Category) in the attribute panel.
	 Step 2: Click the down arrow and select the Manage Groups option.
	 Step 3: Enter an appropriate Group name (for example, Hard Drinks) in the Enter New Group Name dialog box 	
	 and click Done.
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Step 4: Select the desired items from the left side of the selection panel and click the right-pointing arrow to 
move them to the right side of the panel.
Step 5: To create a sub group within a group, select the desired items from the right side of the panel (for 
example, Liquor and Beer) and click the Add to Sub Groups button.

Step 6: Enter the name of the sub group in the Create Sub Group dialog box and click Done.
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Optional: Repeat steps 4 to 6 to create another sub group (for example, "Wine&Beverages") in a similar way.

Note: You can also create a sub group of the remaining items in the selected attribute by simply selecting the Include 
all others checkbox. It will enable you to compare one sub group against the rest of the items in the attribute. You 
also have the option to rename this sub-group if desired by clicking and typing in the text field that currently reads 
“All Others”.

Step 7: Click Save. The system displays the success message "Groups saved successfully."
Step 8: Click Done. 

Users will find the group (for example, "Hard Drinks") denoted with a "G" prefix in the attribute panel as shown in the 
screenshot.
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Running a report with a Grouped variable (for example, "Hard Drinks") will provide sum total for each specified sub 
groups (for example, All Others, Wine&Beverages, Liquor&Beer) separately as shown in the below screenshot.

Copy Group/Edit Group Name/Delete Group
Users can make a copy of a Group, edit a Group name, or delete a saved Group by following the below mentioned 
procedure:
	 Step 1: Select the desired Group attribute in the attribute panel.
	 Step 2: Click the down arrow and select the Manage Groups option.
	 Step 3: Select the appropriate Group name from the Name dropdown list.
	 Step 4: Click the Options dropdown menu and select the Copy, Edit Name or Delete option.
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Manage Dynamic Groups
A Group is a derived attribute created on an existing attribute. It may contain static Lists or Conditional Lists. 
In addition, it can also be composed of a subset of values or these values may be grouped into subgroups/
aggregates. Dynamic groups will be updated with each data refresh, as well as anytime the list/group are 
resaved.

You can create and manage a dynamic group using two options. When you create a dynamic group, both of 
these options are selected by default: 
•	 Link to List - When selected, it will update the group when the list is updated.
•	 Create List Based Subgroups - When selected, the list(s) will be aggregated as a single value instead of a list 

of values. 

In this Quick Start Guide, you will learn to create dynamic groups pertaining to the following scenarios:
•	 Group containing a single list - Aggregate
•	 Group containing multiple lists - Aggregates
•	 Group containing a single list - List Values

Note: List Values are not available for multi-list groups.

Group Containing a Single List - Aggregate
	 Step 1: From the Home Page, select the desired data domain on the right-hand side of the page to open the New 	
	 Report Template screen.
	 Step 2: Select a desired attribute in the attribute panel, click on it to select the Manage Groups option from 		
	 the dropdown menu. 
	 Step 3: Enter an appropriate group name in the Enter New Group Name dialog box and click Done.
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In the new group, there will be a section under the group Name labeled “Select List(s)”. This area opens a drop-down 
with all lists created on this attribute if the selected attribute has any. Selecting a list will populate the right panel with all 
values of that list, as shown below. 

	 Step 4: Select the desired list name from the dropdown menu. 
	 Step 5: Confirm that the Link to List and Create List Based SubGroups checkboxes are selected.  Again, these 		
	 boxes should be checked by default.

For example, the “West Coast States” created on the right would be an aggregate of all the values of the list titled “West 
Coast States”.

	 Step 7: Drag new group onto Rows in the report grid then, click the Generate button.
	 Step 8: As pictured below, this group yields one dynamic aggregate/subgroup.

Note: Dynamic groups do not have the option to add an All Others aggregate, so currently, the Include All Others 
checkbox will be greyed out.

	 Step 6: Click Save and then Done in the Manage Groups window.
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With Link to List selected, the list will be dynamic and will update whenever the related list changes. 

If the user unchecks Link to List, the list will be static and will not change even if the list is modified. Unselecting Link 
to List can be used as a tool to select all or a subset of the Lists values and/or to create subgroup(s) of all or a subset of 
values. By unchecking the Link to List, the Include All Others and Add to Sub Group lists will be re-enabled as well. 

If more than one list is selected from the drop down, the left panel shows the union of the values of the selected lists.

The check box Create List Based Subgroups converts each list into a subgroup (aggregate) value. Similarly, the report will 
output an aggregate for each list in the group.

Group Containing Multiple Lists - Aggregates
In the example below, a group was created using more than one list. Notice that there are two subgroups in the right 
panel. When placed in a report, this group yields two subgroups based on the group definition. The values of each list are 
aggregated and shown in the report.

When more than one list is selected in a group, the Create List Based Subgroups option will be selected and greyed out 
meaning that the user will not be able to change from a dynamic aggregate to a dynamic list of values. This means that 
List Values are not available for multi-list groups. 

Workaround: Create one list containing all desired values (i.e. North East States and West Coast States) as a way to    
create a group of this type.
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Group Containing a Single List - List Values
This last example demonstrates the behavior of not selecting a list-based subgroup in a group containing only one list.

By unchecking the Create List Based Subgroups checkbox, the values of the list in the right panel will be listed 
individually, instead of as an aggregate. The values on the right panel cannot be modified. Again, if Link to List is selected, 
these values will update dynamically as the corresponding lists are modified.

Similar to the example above, see the screenshots below for the behavior when unchecking Create List Based 
Subgroups. Now each value in the West Coast States will be displayed separately.

Dynamic groups can be used in filters and User filters; they will be treated the same as static groups. If Create List Based 
Subgroups is selected for a group (creating aggregate(s)), the subgroup would be shown as a filter value. For groups with 
Create List Based Subgroups unselected, the user will filter on individual values.
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Summary Examples:

Group containing a single list - Aggregate: 

List Values:
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Group containing multiple lists - Aggregates:

Note: See the Manage Lists and Manage Groups Quick Start Guides for more information.
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Chart Screen Walkthrough

1. File - This menu provides options to save, rename, publish, schedule, and export a chart. Some menu options are 
available to the asset owner only.

2. Chart Types - This menu provides different types of charts to choose from including bar, column, line, pie, combo,  
scatter, target, gauge, tree, and so on. Some of them may be grayed out based on the report layout and selections.

3. Chart Elements - Use this menu to specify options common to most chart types such as chart title, hide/show data 
labels, legends, and background color.

4. Chart Properties - Options inside this menu vary based on chart type and enable customization of the data ranges 
used in terms of color, line/bar style, and other factors relevant for the type of chart.

5. Display Options - This menu provides options to manage display of report elements in the chart view such as filter and 
user filter attribute names and selections, footer, report specifications and so on

6. Options - Use this menu option to show/hide data labels, set target values, enable scroll bar and so on.

7. Left Panel - This panel displays the report dimensions used to create the chart. You may move these attributes by 
interchanging their positions among row, columns, pages, and grid and accordingly, the data representation in the chart 
changes.

8. Tabs at the Bottom - Click the Report View tab to visit/change the data report. Click New Tab to add a new chart type 
to the report. After you add a chart type, you can rename, duplicate or delete it by clicking the down arrow of the tab. 
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Create Chart
Step 1: On the Create Report screen, drag the desired attributes from the left panel onto the Row, Columns, 
Page, and Filters areas.
Step 2: Click Generate.

Step 3: After the report is generated, click the New Tab placed beside the Report View tab.
Step 4: Select the appropriate Chart Type from the menu. Options may be limited based on the data in the        
report view.
Step 5: The system processes the request and presents the report in the selected chart format.
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Storyboard Screen Walkthrough

1. File - This menu provides options to save, publish, schedule, and export a storyboard. Some menu options are     
available to the asset owner only.

2. Insert - This menu provides options to add a report, static object, Dashboard title, new Dashboard or an existing   
Dashboard to the Storyboard.

3. Display Options - Use this menu to specify the display options with respect to user filters and scroll bar.

4. Options - Use this menu to rename Storyboard and/or Dashboards, manage user filters, manage Dashboards, and so 
on.

5. Dashboard Navigation - Click the navigation arrows to walk through multiple Dashboards within a Storyboard.           
Alternatively, click the Dashboard link to directly navigate to a specific Dashboard in a Storyboard.

6. Ellipsis - Click the respective Ellipsis icon to modify the corresponding report widget individually. It enables you to:
    • Open a report widget in full screen to modify.
    • Edit/Format border, title, display filters, display source, and dimensions of a widget.
    • Use the Change Report option to replace a report widget with a new report.
    • Specify locks on certain report widgets.
    • Link a report widget to an asset.
    • Link a report widget to an external URL.
    • Delete a report widget.
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Create a Storyboard
Step 1: On the Home screen, click the New button and select the Storyboard option from the menu.  

Step 2: Select the desired Storyboard template. 

Step 3: Click the plus icon to add a desired report into the Dashboard. Repeat the step until you add reports to 
all the placeholders. Or, if you select a Blank template, click the Insert -> Report option to add one report at a 
time. 

Step 4: Click Save.
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Offline Viewer
Introduction
The Dhiva Offline Viewer allows users to download Reports to their browser cache and view them in Dhiva regardless 
of whether they are connected to the internet. The Offline Viewer is available to all Dhiva users, though users licensed 
as Offline Users will only have access to the Offline Viewer module. 

Key Features of the Offline Viewer Module

With an internet connection:	
•	 Download, view, and interact with Reports and Storyboards.
•	 Change chart types or create temporary charts.
•	 Export downloaded Reports and Storyboards.
•	 Download export files scheduled by other users.

Without an internet connection:
•	 View and interact with Reports and Storyboards that were previously downloaded when connected to the        

internet.*
* Requires use of the same device and browser.

There is an indicator of online/offline status in the application status bar.

Accessing the Offline Viewer
Producer and Consumer users can access the Offline Viewer using the menu under their initials in the upper right     
corner of the page.
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Offline Licensed Users (Offline Users) will load the Offline Viewer in Tile View upon logging into Dhiva. This initial screen 
shows assets that are available to the user. There is text and an icon bottom right corner of the tiles which indicates 
whether the asset is a Report or a Storyboard. A checkmark on a tile indicates that the asset has been downloaded to 
the local cache.

The List View provides a more detailed view of the available assets including the data domain, asset owner, presence 
of a Special Attribute, and last download time. Icons at the right provide the ability to export or download assets, view 
information, or delete the Report previously downloaded.

Downloading Assets
To download a Report or Storyboard, click on the name of the report or the Download icon. The assets are            
downloaded to the local browser cache. Once an asset has been downloaded, it will remain available for use without an 
internet connection, provided that Dhiva is accessed via the same device and browser used to download the assets and 
the cache has not been cleared.

If a Special Attribute is present, an additional screen will prompt users to select members of the Special Attribute to 
download. Stores acts as a Special Attribute in most scenarios. The search options at the top of each column can be 
used to filter the list. Up to 10 stores can be selected.
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When selecting multiple stores from the download popup window of a Storyboard, use the Funnel icon to select an 
individual store from those that have been downloaded.

When the Report layout has stores on pages, a dropdown menu in the upper right corner allows users to switch 
between stores if they have more than one store downloaded.

To delete a downloaded asset from the browser cache, click the Delete Offline button in list view.

Exporting Assets
Reports and Storyboards available in Offline Viewer can be exported to other file types. Reports can be exported to 
Excel, CSV, PDF, or PPT; Storyboards can be exported to PDF or PPT.

There are several methods users have access to in order to export a Report or Storyboard. 
•	 Right-click on the asset name in the list view.
•	 Click on the Export icon next to the asset.
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•	 Exit Preview mode, and select Export from the File menu.
•	 If the asset contains a Special Attribute, users will be prompted to select stores to export. This is recommended to 

avoid failed exports due to file size limitations.
•	 To export a single Report or chart from a Storyboard, use the full screen icon in the upper right corner of the 

Report users wish to export, exit preview mode, then choose Export from the File menu.

The Download Manager can be used to view the status of assets scheduled for offline use and to download any         
documents (Excel, PDF, PPT, etc.) scheduled to the account or exported by the user.
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Enabling Content for the Offline Viewer
A user must be a Producer user in order to enable a Report or Storyboard for offline use. To enable an asset for offline 
use, users are able to use either the Schedule or Schedule On Reload menu option from list view or right click on the 
asset.

Under the Schedule options, choose Export type as Offline, then select when and how often the Report will be      	
scheduled to be sent to the Offline Viewer, as well as listing other potential offline recipients.

Note: To run the Report after each data refresh instead of scheduling it on a set frequency, select Schedule On Reload.
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Special Attribute
The Special Attribute is typically a store attribute such as Store Number that has been configured to enable store level 
reporting. The presence of this attribute on rows, columns, or pages of a Report will prompt the download popup     
window to appear when a user tries to download an asset with a Special Attribute. 

Additional Store Attributes such as Store State, City, Address, Zip, Type, etc, appear in the download screen along with 
the Special Attribute and can be configured to help narrow the selection of stores available to download.

Example of a Report with a Store Special Attribute on Pages:

Notes on Special Atrributes: 
•	 The Special Attribute will not prompt the download popup screen to appear when used in a hierarchy.
•	 A Storyboard may contain Reports with and without the Special Attribute. Only Reports with the Special Attribute 

will be filtered when the asset is downloaded in the Offline Viewer.
•	 Consult your MSA client representative for information about using Special attributes in your Dhiva environment.
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Assumptions and Limitations of the Offline Viewer
•	 User filters will not function in the Offline Viewer. The UF will appear on the Report if enabled but will be grayed 

out.
•	 Report links and other links do not work in Offline Mode. The underline that indicates a clickable link will not 	

appear in the Offline Viewer. 
•	 Merged Reports cannot be scheduled for offline use.
•	 Report data limits apply; Reports with assets exceeding the data limits will fail when scheduled for offline use.
•	 Offline users cannot refresh Reports on their own. Recommended practice is for the Producer to use the Schedule 

On Reload option so that the latest data is available when using the Offline Viewer.
•	 Folders are not available in the Offline Viewer. 
•	 If a Special Attribute is present in a hierarchy, it will not prompt the download popup store selection screen to 		

appear.
•	 Nested, Replacement, and Stacked hierarchies can be used in the Offline Viewer.
•	 Offline Viewer is not supported on smart phones.
•	 Offline users can add charts or change chart type while connected to the internet.  These changes are temporary 

and will not be retained after closing the asset or when disconnected from the internet.


